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ABBREVIATIONS 

EKI  Institute of the Estonian Language (Eesti Keele Instituut) 

EVEA Estonian Aviation Academy 

ESTERM Multilingual database of the Institute of the Estonian Language 

EANS Estonian Air Navigation Services 

ILS Instrumental Landing System 

PDF Portable Document Format 

RT Riigi Teataja, official online publication of the Republic of Estonia 
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INTRODUCTION 

Written assignments of learners reflect their ability to apply acquired knowledge and skills in 

discussing practical and theoretical issues. Meeting the requirements for formatting is just as 

important than the content of the work. 

The aim of the guidelines for formatting written assignments at the Estonian Aviation Academy 

(hereinafter the Academy) is to standardise the structure and format of the papers submitted by 

learners. All written assignments, including research papers and theses, should be prepared and 

formatted as instructed in these guidelines.  

The guidelines also include examples provided in blue boxes. Technical instructions described herein 

are based on the assumption that the learner uses the word processing program MS Word and key 

words in italics refer to respective technical solutions of MS Word.Types of written assignments 

For the purpose of these guidelines, written assignment are divided into longer (more than 3 pages) 

and shorter (1-3 pages) papers. Longer papers contain a title page, table of contents, introduction, 

chapters, summary and list of references. As provided for in the rules on organising activities related 

to the theses, the volume of the content of the thesis (introduction, chapters, summary) should be 

about 20-25 pages. The volume of the appendices is not restricted. 

A research paper (incl. thesis) consists of the following parts:  

● title page (see Appendix 1) 

● declaration of the author and approval of the supervisor on allowing the thesis to defence (see 

Appendix 2), 

● summary in English (see Appendix 3), 

● table of contents, 

● used abbreviations and symbols (not obligatory, but provided when more than 10 

abbreviations or symbols have been used), 

● introduction (description of the research problem, aim of the work, research questions or 

hypotheses), 

● theoretical overview (based on at least 10 sources, at least three of them scientific articles), 

● empirical part (description of methods, results and their analysis, conclusions, discussion),  

● summary (the aim of the work, main results, answers to research questions, conclusions 

regarding the hypothesis, practical application of the work, ways for development), 

● list of references, 

● appendices (when needed), 
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● non-exclusive licence authorising the reproduction of the thesis and making it available to the 

public (see Appendix 4).  

Shorter papers (1-3 pages) are submitted without a title page. For headings, unnumbered second 

level style (Heading 2) is used, which is aligned left. The name of the learner, the year of study, 

speciality and date of submission are provided in the right-hand corner of the header (see Appendix 

5).  



6 

 

1 GENERAL REQUIREMENTS  

Generally, papers are submitted as electronic files in PDF format A4 (210 x 297 mm). All pages 

have the top, bottom, left and right margins of 2 cm (Layout→ Margins → Custom → Margins).  

1.1 Style and language 

Linguistic and stylistic accuracy of the work is essential. In papers, academic language and correct 

specialised terminology should be used. Throughout the work, the style and form of language must 

be consistent. The author should remain unbiased in reporting the views of different parties. 

Instead of first-person pronouns “I”, “we” (e.g., “we studied”, “I analysed”), the passive voice (“is 

discussed, analysed, studied, assessed”, “has been discussed, analysed”) should be used. The 

indicative mood is preferred over the extensive use of the conditional mood, which may give an 

impression that the writer is not convinced of the accuracy of the position expressed in the paper. 

Correct terminology in Estonian can be found in the multilingual database of the Institute of the 

Estonian language (EKI) ESTERM, which mainly contains terminology used in the legal acts of 

the European Union and the Republic of Estonia. The database contains technical terms related to 

more than 50 fields of activity (incl. aviation) and can be accessed at the address 

http://termin.eki.ee/esterm/. ESTERM is supplemented and kept updated by the terminologists of 

EKI. (Eesti Keele Instituut, 2022) 

If there is no adequate term in Estonian, a suitable equivalent should be suggested and the 

corresponding foreign language term added in parentheses. Words and phrases in foreign 

languages should be italicised (Italic).  

1.2 Headings and table of contents 

The major independent parts of the paper (table of contents, summary in a foreign language, 

introduction, chapters, list of references) start on a new page (Insert → Page Break). 

The headings should not contain abbreviations and have no full stop at the end. The headings are 

aligned to the left side of the page (text alignment Align Left). The space between the heading and the 

text that follows (or precedes on the same page) is 12 points. The automated heading formatting 

system is used for headings (Heading 1, Heading 2, Heading 3), which is later necessary for 

formatting automatically the table of contents. 

The heading are formatted as follows: 

● Heading 1: Times New Roman, font colour: black, 16 points, bold (Bold), upper case. 

Each chapter starts on a new page (Line and Page Breaks → Page break before).  

http://termin.eki.ee/esterm/
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1. CHAPTER HEADING 

● Heading 2: Times New Roman, font colour: black, 14 points, bold (Bold); 

1.1. Chapter heading 

● Heading 3: Times New Roman, font colour: black, 12 points, bold (Bold). 

1.1.1. Chapter heading 

1.3 Formatting the text 

The font to be used for text is Times New Roman (incl. tables, figures, formulae) with the font size 

of 12 points. Paragraphs are aligned to both left and right (text alignment Justified). The text is divided 

into paragraphs with the amount of space of 12 points between paragraphs (Page Layout → Spacing), 

line spacing is 1.5 (Line Spacing) and paragraphs start without an indent. In order to avoid unjustified 

line breaks in the text, non-breaking spaces are used (combination <Ctrl> + <−>). 

All pages, except the title page, are numbered and page numbers are placed at the bottom centre 

of the page. The title page is counted, but no page number is added to it (Insert → Page Numbers, 

Different First Page). 



8 

 

2 REFERENCING  

2.1 General principles 

In academic papers, often the views or data are used as source materials that are known or have been 

published before. Under copyright law, citing the original author in written assignments is 

compulsory whenever the ideas of other authors, for example, or data gathered by someone else are 

used. Using the work of other authors without referencing is called plagiarism. Under the Study 

Regulations of the Academy, plagiarism or theft of intellectual property is deemed improper 

behaviour, academic misconduct and material breach of academic practices. 

Using the work of other authors is only permitted when the original author is cited or referred to. A 

direct quote indicates material that is being reproduced word for word from a text written by some 

other author and must be set off by quotation marks with the citation right after the end of quotation 

marks. Paraphrasing means expressing the position of another author using different words. If the 

citation refers to only one sentence, it is placed before the full stop. If the citation refers to the whole 

paragraph, it comes after the full stop ending the last sentence of the paragraph.  

2.2 Citation styles 

There are different citation styles, but in one text only one of the systems is used. According to the 

guidelines for formatting academic papers, the following citation styles are permitted:  

● citation in the name-year system (APA style) - widely used in the social sciences; 

● numeric citation (IEEE style) - used mainly in papers on electronic and electrical 

engineering and computer science.  

In the APA style, in-text citations include the author’s name and publication date in parentheses. 

If the source has no author, the heading is used instead of the name and the year of publication 

is added. The list of references at the end of the work is alphabetised by the surnames of authors. 

In the IEEE style, in-text citations include numbers enclosed in square brackets. In the list of 

references at the end of the work, numbered sources are listed in the order of the appearance of 

in-text citations in the text. 

2.3 Managing citations 

There are several technical means for managing citations. For example, the function integrated in MS 

Word or some reference management software (e.g., Mendeley, Zotero) may be used.  

https://apastyle.apa.org/style-grammar-guidelines/references/examples
https://ieeeauthorcenter.ieee.org/wp-content/uploads/IEEE-Reference-Guide.pdf
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MS Word includes an opportunity to use tools found under References → Citations & Bibliography. In 

order to add a citation, select Insert Citation, for managing reference entries, use Manage Source, and to 

add the list of references, select Bibliography. The list of reference at the end of any paper must include 

all sources cited in the work, and vice versa – every entry in the list of references must have a citation 

in the text.  

Citation management programs are software packages that allow us to collect, arrange and use 

bibliographical references. Usually, they can be connected directly with a word processing software 

or web browsers. After the code linked to a certain citation is entered, the programs automatically 

create bibliographies formatted in accordance with specific requirements of a journal or style guide. 

Mendeley (mendeley.com) is a reference manager software of Elsevier, an academic publishing 

company, which allows you to: 

● create a collection of references that can be easily organised and managed;  

● read, annotate and write notes and commentaries in the PDF files added to your references; 

● insert in-text citations in the document easily and quickly while writing, and to create a 

reference list in just a click;  

● communicate with others in your field of study (e.g., your supervisor), set up a research team 

or join other research teams. (Reference management tools, n.d.) 

Mendeley guides in English are available at: http://community.mendeley.com/guides.  

https://www.mendeley.com/
http://community.mendeley.com/guides
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3 FORMATTING THE PARTS OF WRITTEN ASSIGNMENTS 

3.1 Abbreviations 

It is recommended to use abbreviations for long names and terms that are used repeatedly, but 

their meanings have to be explained in the text. If there are more than 10 abbreviations in the work, 

they should be listed separately along with their meanings (see the formatting in the list of 

abbreviations used herein). Generally known abbreviations (etc., e.g., i.e., mln, for example) are 

not included in the list because their meaning can easily be found (abbreviation used in Estonian 

are available at the web page of EKI  (Erelt, Erelt, & Ross, 2007).  

Instrument Landing System (hereinafter ILS) means a precision radio navigation system that 

provides short-range guidance to aircraft. 

3.2 Lists 

On each level, a list must contain at least two items. The use of different styles should be avoided and 

lists should be formatted in a similar way throughout the text. Starting and finishing a chapter with a 

list should be avoided. When using a list within a text, it should be considered how to link it to the text 

that precedes or follows it in a logical manner. The items in a list are marked with numbers, lower case 

letters or bullets. Line spacing should be 1.5 in lists and paragraph spacing 0. Lists should not be overused 

in a text. If a list consists of single words or short phrases, a comma is used to separate them.  

To apply for a study place at the Academy: 

● the candidate is required to hold at least the Certificate of General Secondary 

Education or equivalent certificate from a foreign state,  

● the candidate must submit an application for admission, 

● the candidate must meet the language proficiency requirements.  

 

If any of the items includes a comma or any other punctuation mark(s), a semicolon is used to separate 

the items. The first letter of the first word of the item is lower-cased and letters or numbers followed 

by a round bracket are used to identify each item. 

If any of the items consists of at least two sentences, the bracket after the item number is replaced by 

a full stop. If any of the items also includes a list, the items of the more general list are identified by 

numbers, the items in the subordinate list by letters. 

http://www.eki.ee/books/ekk09/index.php?p=2&p1=9&id=67
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3.3 Tables 

All tables in papers are labelled (“Table") and numbered sequentially throughout the work (which is 

recommended if there are more than 10 tables), or throughout separate chapters if the number of 

tables is greater. For example, “Table 1.” or “Table 3.4.”. The same system is recommended for 

labelling figures and formulae. For labelling and numbering the tables use References → Insert 

Caption, for formatting the captions that identify and describe tables, use the section Caption: font 

size 12 pt, line spacing 1.5, left aligned, 6 pt space between the caption and the table. For the text 

within a table, font size of 10 to 12 pt and line spacing 1 (Single) is used. The text in the table is in 

the language in which the paper is written (see Table 1).  

Table 1. Average gross salary in 2011 – 2016, in euros (Statistikaamet, 2017) 

 2011 2012 2013 2014 2015 2016 

I quarter 792 847 900 966 1,010 1,091 

II quarter 857 900 976 1,023 1082 1,163 

III quarter 809 855 930 977 1045 1,119 

IV quarter 865 916 986 1,039 1,105 1182 
 

All data provided in tables must be linked to and discussed in the text (e.g., “Table 3 characterises...“ 

or “See table 8“). For referencing use References → Cross-reference. The caption of a table should 

also include the source(s) of the data not created by the author of the paper. 

It is recommended to fix in-text data tables to one page, i.e., breaking tables over two pages should 

be avoided. Large data tables are provided in appendices. If a table reaches over several pages, the 

header rows of the table are repeated (Repeat header rows).  

3.4 Figures 

Figures may be illustrations, diagrams, charts, graphs, maps, drawings, schemes, pictures or 

photographs. Each figure must have a captions below it (the content of the caption is not repeated in 

the figure). Similarly to tables, all figures are numbered. For labelling and numbering the figures use 

References → Insert Caption. The label “Figure” with its caption is aligned left. In captions, font size 

is 12 pt and line spacing 1,5. A space of 6 pt is left between the caption and the figure. The text in the 

figure is in the language in which the paper is written.  

 



12 

 

Figure 1. Share price of Google in January 2023 (Alphabet Inc. (GOOGL), 2023) 

All figures should be referred to in the text. A figure is positioned in a suitable place after it has been 

referred to in the text. Similarly to tables, the source of data is cited, where necessary. Generally, 

figures created by the author of the paper are used. 

3.5 Formulae 

Formulae and symbols used in them are italicised (Italic) and the font size of 12 pt is used. For 

formatting, the formula editor is used (Insert → Equation). All formulae are numbered and the 

number is placed in parentheses on the same line with the formula (preferably aligned right). 

Measurement units are added not to the formulae, but to the explanations of symbols, using the 

upright style (i.e., non-italic). The explanations of formulae are started with the word “wherein” 

(without a colon following) and, for the sake of clarity, provided one below the other. Under each 

new formula, only the symbols occurring for the first time are explained. 

The formula for calculating wavelength (λ) is as follows: 

𝜆 =  
𝑐

𝑓
,   (1) 

wherein   

λ (m) – wavelength,  

c (m/s) – light speed,  

f (Hz) – frequency.  
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3.6 Appendices 

All numerical data and other materials that are either too voluminous or required to discuss a problem, 

but not necessarily needed in the text, are presented in appendices (e.g., supporting materials, 

questionnaires, tables, etc.).  

All appendices are numbered in Arabic numerals in the order they are referred to in the text, in bold 

and aligned left (“Appendix 1. Title page format”), and followed by the caption of the appendix. 

There is no full stop after the last word of the caption. Each appendix starts on a new page. If the text, 

picture, table, etc. presented in the appendix is not created by the author of the paper, the source must 

be precisely cited. 

The captions of the appendices are not listed in the table of contents. Before the first appendix, there 

is a page with the title “Appendices” and their list (see Appendices).  
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Appendix 1. Title page format 

Estonian Aviation Academy 
Curriculum of Aviation Management 

 

 

First name Surname 

TITLE OF THE PAPER  

Thesis / Research paper / Review / Report 

Supervisor: First name Surname 

Consultant: First name Surname 

Tartu County 2023 
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Appendix 2. Declaration of the author and approval of the supervisor for defence 

Author’s declaration 

I declare that I have written the thesis independently. All works of other authors and their fundamental 

views used in the thesis, also data found in literature or other sources are accurately cited. 

/signed digitally/ 

Author: First name Surname 

 

Approval of the supervisor for defence 

I confirm that the thesis meets the graduation thesis requirements of the Estonian Aviation Academy. 

/signed digitally/  

Supervisor: First name Surname 
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Appendix 3. Summary in English1 

SUMMARY 

Title of the thesis in English 

Stating the goal of the thesis, providing background information, why important, the method, the 

number of chapters 

The content of chapters (in the list format): 

Chapter 1 describes / addresses / contains / covers / discusses / provides / presents / explores / 

examines etc. 

Present the findings / results / most important facts 

Make suggestions for further research, where the results can be used 

Optional: Expressing gratitude / Acknowledgements.  

  

 
1

 Impersonal – “The author” 

Present tenses and passive used 
To add more points: Also, What is more, Furthermore, In addition to this/that 

To introduce contrasting viewpoints: On the other hand, However, Nevertheless, In spite of 

To introduce examples: for example, for instance, such as 
To conclude: To sum up, In conclusion, To conclude 
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Appendix 4. Non-exclusive licence for the reproduction of the thesis and making it available to the 

public 

Non-exclusive licence for the reproduction of the thesis and making it available to the public 

Date in digital signature 

I, First name and Surname, hereby grant the Estonia Aviation Academy a free (non-exclusive) 

licence for my thesis 

TITLE OF THESIS 

supervised by First name and Surname, 

1.1. to be reproduced for the purpose of preservation and making it available to the public, 

including to be entered in the digital archives Riksweb of the Estonian Aviation Academy for 

the full term of copyright protection; 

1.2. to be made available to registered users of the library of the Estonian Aviation Academy in 

the digital archives Riksweb for the full term of copyright protection. 

2. I am aware that the author retains the rights specified in clause 1.  

3. I confirm that granting the non-exclusive licence does not infringe any other persons’ 

intellectual property rights and the rights arising from the Republic of Estonia Personal Data 

Protection Act. 

 

/signed digitally/ 

Author: First name Surname 
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Appendix 5. Example of formatting short papers 

First name Surname 

Year X 

Curriculum (and speciality) 

DD.MM.YYYY 

Lorem ipsum 

„Lorem ipsum is a pseudo-Latin text used in web design, typography, layout, and printing in place 

of English to emphasise design elements over content. It's also called placeholder (or filler) text.“ [1] 

… 

… [2] 

… 

… 

 

 

List of references 

1. Lorem ipsum [http://generator.lorem-ipsum.info/] Accessed on: 27.11.13. 

2. … 

 

http://generator.lorem-ipsum.info/

